
About NutriSoft Omega-3 Counter

Coronary heart disease (CHD) is a term used to identify several cardiac disorders resulting 
from inadequate circulation of blood to local areas of heart muscle. It is generally accepted 
that high blood cholesterol, high blood pressure, and cigarette smoking play causal roles in 
the development of CHD.

Studies have indicated that the consumption of fish and other marine animals may confer 
special benefits in reducing CHD mortality. The fatty acids in these species are rich in long-
chain polyunsaturated fatty acids of the Omega-3 series. Early observations in Greenland 
suggested that Eskimos who habitually consumed large quantities of fish and other marine 
animals had a low incidence of CHD despite a high fat and cholesterol intake. Similar 
observations have been made in other maritime communities. Subsequent examinations of 
Greenland Eskimos showed that they have lower serum triglycerides and cholesterol levels 
and higher HDL levels than Danes consuming a Western-type diet. The blood of Eskimos also
takes longer to clot. It has been hypothesized that the low incidence of atherosclerosis and 
thrombosis in Greenland Eskimos is partly attributable to the high proportion of omega-3 
fatty acids in their traditional diets.

NutriSoft Omega-3 Counter analyzes the Omega-3 content of approximately 250 most 
common food items. Many of these foods are those that have the highest concentration of 
Omega-3. The program also provides cholesterol, total fat and saturated fat data on these 
food items.



Disclaimer

The data and nutritional guidelines contained in this program are derived from research published by US 
government agencies and by private non-profit health organizations. The data and guidelines are 
compiled for your information only and must not be construed as medical advice or instruction. The 
decision concerning diet or medications should be made by you and your doctor. Before adopting any diet
or exercise program, please discuss your condition with your doctor and obtain his/her approval. NutriSoft
disclaims all liability in connection with the use of this program.



Edit meals

If you would like to reuse a meal (or repeat a few food items) in your diet, here is a convenient way to do 
so: prepare the meal (or the food items) you plan to reuse. Copy or cut it to the clipboard; then go to 
another meal or open another day's file and paste to a new meal! The serving information is retained, not 
just the food name. When you insert a meal into a partially planned meal, the inserted food items will 
appear immediately below the currently selected food item in the receiving meal.
You can also delete all food items from a meal by using the Edit Clear All command or the Clear All icon.



Search mode

This is one of the most convenient features of NutriSoft programs. It allows you to find any particular food 
items from the standard and user databases without your having to browse through different categories of
food groups.

When this mode is selected, an edit control is displayed in place of the Food Group combo box and 2 
search icons are shown. You type in the name of the food item you want to find, for example "apple", then
click on one of the search icons. The list box will be filled with all food items containing "apple". You don't 
need to type in a complete word: "app" will suffice. On the other hand, when there are too many matching 
food items, you might want to restrict the match by specifying longer name such as "apple juice" or do a 
local search after having the result of the global search. The search is not case sensitive: you can use 
lower or upper case letters and this won't affect the result.

To exclude food items, use ! (the exclamation point) before the text string. Search on !spinach will 
display all items that do not have 'spinach' in their names.

The program will look for matching entries not only in the standard food database that comes with your 
software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other mode.

In the registered version of the software, there is no restriction on the size of the user database on which 
the search will be performed. However, memory limitation of your system might prevent the display of all 
matched entries in the list box. In this case, a message box will appear to alert you of this situation.

In the shareware version, search will be performed on the abbreviated standard database and on the first 
several records of the user database.

Global search: searches both the NutriSoft and user databases for a food item containing or not 
containing a text string. On a 486-33 system, a global search takes just under 5 seconds.

Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items.

Tip: 
After entering the text to be searched, you can use Alt-G to do a global search or Alt-L to do a local 
search without having to use the mouse to click on a search icon.



Serving amount

If necessary, you can adjust the amount consumed for a food item by typing the desired amount in grams 
in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 
'Amt. OK' to confirm and record this value.

For your convenience, we have provided 2 popup menus which you can use to quickly adjust the amount 
of servings:

- a left mouse button click anywhere on the background of the document window will display a selection of
common serving sizes. If the serving size is 1 cup (the serving size or unit is enclosed in square brackets,
for example, [1 cup]), selecting .5 indicates that you consume half a cup of a particular food item. How 
much half a cup weighs and the nutrient contents of this amount of food are adjusted and recorded 
automatically for you. You can turn off this feature via the Options menu.

- a right mouse button click will display a selection of common servings in grams, ounces, or common 
serving sizes. When you release the mouse button after selecting an amount, the amount in the edit box 
and other data will be updated automatically. You can also choose the preferred input type via the Options
menu.



Quick Serving Entry in Ounces

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in ounces for quick data input.



Quick Serving Entry in Grams

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes in grams for quick data input.



Quick Serving Entry in Common Serving Sizes

This option allows you to hold down the right mouse button on the main window's background and select 
one of the standard serving sizes for quick data input.



Sorting:

You can quickly identify food items high or low in certain nutrients by sorting them. Since the nutrient 
values are those contained in 100g of each food item, you can directly compare different items and easily 
select the appropriate foods to meet your dietary requirement.

clicks this icon to sort the items in the listbox in ascending order. A selection menu will appear to let you 
specify which particular nutrient you want to sort on.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order, you can click on a food item to view the particular
nutrient's content.



Desirable Weight

This utility calculates the normal weight based on a person's height, sex and age. 

If you are too fat or too thin, your chances of developing health problems are increased.
Being too fat is common in the United States. It is linked with high blood pressure, heart disease, stroke, 
the most common type of diabetes, certain cancers, and other types of illness.
Being too thin is a less common problem. It occurs with anorexia nervosa and is linked with osteoporosis 
in women and greater risk of early death in both women and men.

Whether your weight is 'healthy' depends on how much of your weight is fat, where in the body the fat is 
located, and whether you have weight-related medical problems, such as high blood pressure, or a family 
history of such problems.

What is a healthy weight for you? There is no exact answer right now. Researchers are trying to develop 
more precise ways to describe healthy weight. In the meantime, you can use this utility to help judge if 
your weight is healthy. Find out if your weight is within the normal range. The range is higher for people 
35 years or older than for younger adults. This is because recent research suggests that people can be a 
little heavier as they grow older without added risk to health. Just how much heavier is not yet clear. The 
weight ranges given by the utility are likely to change based on research under way. The current data are 
derived from Diet and Health (National Research Council, 1989).
Ranges of weight are given by this utility because people of the same height may have equal amounts of 
body fat but differ in muscle and bone. The higher weights in the ranges are for people with more muscle 
and bone.
Weights above the range are believed to be unhealthy for most people. Weights slightly below the range 
may be healthy for some small-boned people but are sometimes linked to health problems, especially if 
sudden weight loss has occurred.
Please consult with your doctor to find out what is the optimal weight for you. Because individuals differ, 
your optimal weight may be lower or higher than the normal range.

Use the spin controls in the dialog box to specify your height (without shoes). Specify your sex and age by
selecting the appropriate radio buttons.
To plan your weight loss use Weight Control Plan.

If you close the dialog box by clicking the OK button, the information will be saved and redisplayed next 
time you invoke the dialog box. Use the Esc key to close the dialog box without saving.



Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake." 

U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when the program should warn you when a 
food item exceeds the limit. A green or red symbol is displayed appropriately. You can click on the symbol 
to invoke the dialog box.

When you print out your nutritional analysis of your diet, each fatty food will also be marked with an 
asterisk for easy recognition.



Caloric Need and Nutrient Requirements

This dialog box calculates your daily caloric need and recommended intakes of important nutrients 
according to your age, ideal weight, activity level.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges from 1 
(sedentary) to 10 (strenuous). 

Suggested total fat intake is based on the American Heart Association's and the Food and Nutrition 
Board's recommendation that no more than 30% of your calories come from fat. 

Recommended intakes of other nutrients are based on the Surgeon General's recommendation and on 
the National Research Council's data.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the current information is saved for next time you invoke the dialog box.

The dialog box must be filled out at least once: when you run the application for the first time, the dialog 
box is automatically presented to obtain your individual information. You can revise the information 
anytime.



Weight Control Plan

It's hard to achieve your weight goal without planning. This utility allows you to establish a plan and 
estimate precisely how much weight you will gain or lose when you follow this plan. 

First, please specify your current weight and activity level by clicking on the appropriate spin controls. The
activity levels range from 1 (for those having sedentary lifestyle) to 10 (for those having physically 
strenuous occupations). The dialog box displays the number of calories required for you to maintain your 
current weight.

The 'Daily consumption' list box (on the right) should contain several files for you to add to your plan (the 
list box on the left). Please note that you must have previously saved some files before you can use this 
dialog box. Or you can try out the sample daily food consumption files we provide.
Let's assume you've prepared 7 daily menus and name them Sun, Mon, Tue, etc. [The program 
automatically adds in the standard extension for your files, please use the standard extension.] These 
files should appear on the right hand side list box. You add the files one by one to your plan by selecting 
them then click on the 'Add to Plan' button or by double-clicking the file names.
As you add in these files, the dialog box automatically calculate the amount of weight you should gain or 
lose if you follow your plan, the average daily caloric intake and the average fat content of your plan.

NutriSoft weight control plan is truly flexible: you can set a food plan to be repeat every week, every 3 
days or every 10. You can also anticipate your future weight when your plan is repeated during this period
by adjusting the number of days in the period via the spin control.

Once an entry is added into your plan, you can select it then click on the 'chart' button to review its 
nutritional content. 
In general, you should not try to achieve significant weight loss in just a few days. Please consult your 
physician regarding your weight loss goal. Even an energy deficit of just 500 kcal a day should result in a 
loss of approximately 1 pound per week or 50 pounds a year!

After setting up your plan, print out a report to keep track of your food intake and to motivate yourself to 
achieve your goal.



Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat? This graph 
displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combo box and the graph shows the percentage of protein that comes from 
breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in counter clockwise order. 

The analyses are provided for weight, calories, protein, carbohydrate, fat, and other essential nutrients 
when available. These analyses are very convenient when you want to spread out your energy intake 
throughout the day instead of concentrate your food consumption in infrequent big meals.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit 
Esc. If you click OK, the currently selected nutrient will also be initially selected next time you invoke the 
dialog box.



Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the current day or 
for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food consumption. 
The right graph shows the day's caloric intake and a pie chart depicting the percentages of calories from 
protein, carbohydrate and fat in counter clockwise order. Each nutrient is color coded for easy 
identification.

You should pay particular attention to the percentage of calories from fat. The American Heart Association
recommends that your total fat intake be no more than 30 percent of your total calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.



Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want to be alerted. 
For example, if you want to identify foods that has more than 50% of their calories derived from fat, you 
should set this value through the Set Fat Warning Level dialog box. From then on, each time a food item 
is consumed, a green or red symbol will be displayed to indicate whether its fat content is below or above 
the limit you set. When you print out your nutritional report, each food item exceeding this limit is also 
flagged with an asterisk before its name.

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.



Set Nutrient Intake Preference

How much of each nutrient do you want to consume each day? Use this dialog box to set your own 
preference. The color of the RDA analysis bars will reflect your preference. The bars are green when you 
consumption is within your preferred range, yellow when you are not having enough of a nutrient, 
magenta when your intake is somewhat above the optimal range, and red when the consumption is 
considerably higher than desired.

Click on the Use RDA button if you want the Recommended Dietary Allowance value for any particular 
nutrient. Please note that the RDA values are for an average individual. You might need to adjust your 
optimal intake accordingly.



Caloric Analysis

Do you need a more healthful diet? This menu item displays a graph showing the number of calories in 
your diet that comes from protein, carbohydrate or fat.



Nutrient Analysis

Are you eating too much at dinner and not enough at breakfast? Check out the relative nutrient intakes of 
all your daily meals.



Weight Control Plan

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for any number 
of days. Find out how much weight you will gain or lose in a week, a month or a year; and whether you 
are consuming too much fat in your plan.



Caloric Need

Find out how many calories you need a day based on your age, desirable weight and activity level. The 
dialog box also shows the maximum recommended fat consumption in your diet.



Desirable Weight

This menu item displays a dialog box which allows you to determine your ideal weight based on your sex, 
height and body frame.



Find Food Item with Lowest Content of a Nutrient

Click this button to search for food item in your day consumption that has the lowest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
useful when you want to keep the consumption of a particular nutrient low. For example, you can find food
items with lowest fat content and consume more of these items without worrying about quickly increasing 
your fat intake. If your day's consumption has several items with the same low fat content in different 
meals, the program cycles through these items each time you click on this button.



Find Food Item with Highest Content of a Nutrient

Click this button to search for food item in your day consumption that has the highest amount of a 
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is 
very useful when you want to quickly lower or raise the consumption of a nutrient. For example, your day 
consumption is too high in fat. You can use this button to identify the food item that most contributes to the
high fat content and adjust your consumption of this item accordingly.



Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight Planning Report.



Choose Screen Color

Some monitors flicker noticeably when certain colors are displayed. Use this option to select the most 
pleasing color for your screen background.



Body Mass Index

Are you thin, or are you overweight? This dialog box uses the Body Mass Index (BMI) which is derived 
from your height (without shoes) and weight (without clothes) to chart your precise standing. Compare 
your BMI with that of an average person, or an obese individual.



Caloric Expenditure of Common Activities

This utility allows you to calculate how many calories you burn by exercising or by doing many of the 
usual daily activities. The registered database contains information on 130 common activities. You should 
select an activity and set it (via the 'Set Favorite Activity' button) as your favorite activity. Once this has 
been set, each time you consume a food item, its caloric equivalence in terms of your favorite activity is 
calculated and displayed on the status bar at the bottom of your screen. For example, you set Tennis as 
your favorite activity and you weigh 160 lbs.; when you drink a cup of milk, the caloric equivalence of this 
food item is 18 minutes of Tennis. This means it takes you 18 minutes of playing tennis to burn away the 
calories contained in one cup of milk!

Another interesting piece of information the Caloric Expenditure dialog box provides is how much exercise
it takes to lose one pound of weight. Let's say you weigh 155 lbs. and usually play tennis for an hour each
time you get to play. The dialog box figures out you need to repeat this activity (an hour of tennis) 7 times 
to burn away one pound of weight, everything else being equal. Please note that this is not an advice for 
you to go out and play tennis 7 times to achieve this weight reduction! The information is presented so 
that you can have another measure of the relationship between weight loss and physical exercise. Before 
embarking on any exercise program, you should obtain approval from your doctor.



Show CSI

This option toggle the display of the Cholesterol Saturated Fat Index.



Reverse Food Groups

This command reverse the current display order of the food group names in the Food Group drop down 
list box.



Left Mouse Button

This option toggle the quick input mode of the left mouse button.



Frequently Asked Questions

Q. What are the benefits of registering this software?
A. 
1. Registered users receive an upgraded diskette having an expanded food database. Some registered 
products have printed guides or manuals. Please note that we use several food databases and they differ 
in size. In addition, we regularly update our programs and data and will send you the most current 
version.

2. The registered version of the software processes all food items in the user's personal database. In the 
shareware version, you can prepare as large a personal food database as you have data for but the 
program makes use of (sorts, searches or displays) only the first several entries in this database.

3. In addition to free technical support, registered users receive deep discount on future registrations of 
NutriSoft products. Fee for upgrading to later version of the same program is also minimal.

Q. How can I register for NutriSoft software?
A. You can register by mail, by phone using credit card, or through the CompuServe Shareware 
Registration Service. Please see the registration topic for more information.

Q. Which NutriSoft program is best for me?
A. You may want to use the following steps to select the software:
1. select the program that analyzes all the nutrients and has all the features you require, if there is 

more than one
2. select the program that has the larger food database, then
3. select the program that has the later version number, then
4. select the program that costs less.

Q. How much does it cost to upgrade to newer versions of NutriSoft products?
A. Registered users automatically receive a free upgrade when there is a minor revision of a product. 
When there is a major new release, the standard upgrade cost is 20% of the registration fee. For 
example, registered users of Weight Perfect 2.0 can upgrade to Weight Perfect 3.0 for $7 which is 20% of
the $35 registration fee of this product.

Q. Is there printed manual for this product?
A. Because of frequent updates to our programs, in general, we provide only on-line documentation: this 
help file. While reading this help file you can print out any topic as needed via the 'Print topic' command 
from the 'File' pull-down menu. 
Starting with version 3.4 or later, some of our products have printed nutrition guides or manuals. Please 
refer to the program specific section in this help file for this information.

Q. What is the best way to get in touch with NutriSoft?
A. The best way to get in touch with us is by email. Our Internet addresses are 
71563.124@compuserve.com and NutriSoft@aol.com. Email is usually answered in the same day. If you 
have to use regular mail, please include a phone number.

Q. What do I do when there is problem running this program?
A. NutriSoft tests its products on the most current versions of Windows before releasing them. As of 
February 95, all of our software (version 3.0 or later) have been successfully tested in the following 
environments:
- Windows 3.1
- Windows for Workgroups 3.11
- Windows NT 3.5
- Windows 95 (latest beta version).



When there is any incompatibility, it is most likely caused by the existence of older .vbx files or libraries on
your machine. To maintain the integrity of your Windows environment, our installation procedure does not 
overwrite or modify any existing files on your computer. In fact, all NutriSoft-related files are installed to a 
single directory (which you specify) to allow easy deinstallation. Therefore, you will need to take the 
following steps to update the .vbx files:
1. save all .vbx files that are in your windows or windows\system directories (to another directory or a 
diskette)
2. also save the following 2 files: gsw.exe and gswdll.dll if they exist
3. copy gsw.exe, gswdll.dll and all .vbx files from the directory where you installed this program to the 
windows or windows\system directory
4. restart Windows then rerun this program.
You can always revert to the original state of your Windows environment by copying back the saved .vbx 
files and libraries if desired.

Q. Where can I obtain other NutriSoft shareware products for evaluation?
A. We encourage you to obtain other NutriSoft products from your current shareware distributor or BBS. A
complete selection of our software can also be downloaded from:

1. CompuServe: the Windows Shareware Forum, Holistic Health Forum (GO HOLISTIC), and Health 
and Fitness Forum (please search on contributor: 71563,124)
2. America Online: the Windows Forum (please search on keyword: NutriSoft)
3. Internet FTP: ftp.cica.indiana.edu, the Center for Innovative Computer Applications ftp site of 
Indiana University. Our files are in directory pub/pc/win3/misc (please search on file names starting 
with "ns"). Another ftp site which has our latest programs is oak.oakland.edu (directory 
SimTel/win3/food).



About NutriSoft

NutriSoft was established by a group of Stanford University researchers to provide consumers with quality
software to help them achieve better health. Your suggestions and comments on our products are much 
appreciated. Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309
America Online: NutriSoft
CompuServe: 71563,124
Internet: NutriSoft@aol.com or 71563.124@compuserve.com

We welcome inquiry from authors, institutions, and publishers who would like to distribute our products or 
customize our software to use with their own nutritional data. We also license our technology (including 
source code) and provide technical consulting services to other nutrition software companies.

List of software products released by NutriSoft as of March, 1995:

1. Fat and Cholesterol Counter for Windows v. 1.1 ($19)
This program is a perfect companion to American Heart Association's Fat and Cholesterol Counter, a 
guide for everyone who wants a more healthful diet.

2. NutriSoft Pregnancy Nutrition for Windows v. 2.1 ($39)
The program, developed from the latest findings of the American Academy of Pediatrics and the National 
Academy of Sciences, is the best nutrition software for a mother's health and that of her child.

3. NutriSoft Healthy Heart Nutrition for Windows v. 3.5 ($35)
The most effective dietary strategy to reduce heart disease risk.

4. NutriSoft Reduce Cancer Risk for Windows v. 3.0 ($39)
Based on studies of the National Cancer Institute and US Surgeon General's dietary guidelines, this 
program can help you lower the risk of cancer from diet.

5. NutriSoft Weight Perfect for Windows v. 3.0 ($35)
Indispensable to anyone who wants to achieve a more desirable weight. Has large food database of 
approximately 10,000 items.

6. NutriSoft High Blood Pressure Nutrition for Windows v. 3.2 ($39)
The program is based on the report of the Joint National Committee on Detection, Evaluation, and 
Treatment of High Blood Pressure. An excellent nondrug approach to treatment for and prevention of high
blood pressure.

7. NutriSoft Lower Your Cholesterol for Windows v. 3.2 ($39)
More than half of all adult Americans have a blood cholesterol level that is higher than desirable. This 
program helps you conform to the cholesterol-lowering dietary guidelines of the National Cholesterol 
Education Program and National Heart, Lung, and Blood Institute.

8. NutriSoft Diabetic Nutrition for Windows v. 3.3 ($39)
Essential tool for accurate monitoring of diabetic diet. Includes sugar analysis of common foods and 
weight control planner.
[ Registered users of Control Diabetes version 1.2 can purchase this program for $19. ]

9. NutriSoft Pyramid Weight Loss Diet for Windows v. 3.4 ($29)
The program analyzes user's weight control diet for conformance with the USDA Food Guide Pyramid in 
addition to the National Research Council's RDAs. Has standard database of approximately 1,000 most 



commonly used food items.

10. NutriSoft Nutrition for Women for Windows v. 3.5 ($39)
A complete nutrition guide for women of all ages.

11. NutriSoft Sugar Content of Foods for Windows v. 3.3 ($19)
Analysis of over 500 foods for glucose, lactose, fructose, galactose, sucrose, maltose and other sugars.

12. NutriSoft Eat Well, Weigh Less for Windows v. 3.5 ($37)
The program helps you design nutritious and well-balanced meals to lose weight. Has large database of 
foods and new utilities such as weight log and diet tracker.

13. NutriSoft Omega-3 Counter for Windows v. 3.4 ($19)
Analysis of 250 foods with highest concentration of Omega-3. Also their fat and cholesterol data.

14. NutriSoft Nutritionist Office for Windows
Register for 3 or more copies of any NutriSoft products and receive a 20% discount.

Several of our products have been adapted to use a German food database:

1. NutriSoft Ernährung für Frauen for Windows v. 3.5 ($39)
2. NutriSoft Ernährung bei Diabetes for Windows v. 3.5 ($39)
3. NutriSoft Das optimale Gewicht for Windows v. 3.5 ($35)
4. NutriSoft Ernährung bei Bluthochdruck for Windows v. 3.5 ($39)
5. NutriSoft Diät bei Herz-Kreislauf-Erkrankungen for Windows v. 3.5 ($39)
6. NutriSoft Cholesterinsenkende Kost for Windows v. 3.5 ($39)

See also
Order form
Order form (German products)



Registration Form
[This form can be printed by selecting 'Print topic' from the File pull-down menu.]

Please indicate which software product(s):

1. Fat and Cholesterol Counter for Windows v. 1.1 ($19)

2. NutriSoft Diabetic Nutrition for Windows v. 3.3 ($39)

3. NutriSoft Weight Perfect for Windows v. 3.0 ($35)

4. NutriSoft Pregnancy Nutrition for Windows v. 2.1 ($39)

5. NutriSoft High Blood Pressure Nutrition for Windows v. 3.2 ($39)

6. NutriSoft Healthy Heart Nutrition for Windows v. 3.5 ($35)

7. NutriSoft Reduce Cancer Risk for Windows v. 3.0 ($39)

8. NutriSoft Lower Your Cholesterol for Windows v. 3.2 ($39)

9. NutriSoft Pyramid Weight Loss Diet for Windows v. 3.4 ($29)

10. NutriSoft Omega-3 Counter for Windows v. 3.4 ($19)

11. NutriSoft Nutrition for Women for Windows v. 3.5 ($39)
12. NutriSoft Eat Well, Weigh Less for Windows v. 3.5 ($37)

Name:

Address:

City: State: Zip:

How did you obtain this NutriSoft shareware? _______________________________

Your email address, if available: _______________________________

Please send check or money order to
NutriSoft

P.O. Box 8226
Stanford, CA 94309

International order: please remit in U.S. currency and add $1 for airmail postage. Because of high 
processing fee from our bank, we can no longer accept personal check from a non-US bank. Please use
money order from your bank, local American Express office, or postal money order. CompuServe users 
should use the CIS Shareware Registration Service.

See also 
German edition registration
Registration by Credit Card



Registration via CompuServe

Members of CompuServe can register for any NutriSoft products through its Shareware Registration 
Service (GO SWREG).

Please search for our products using "NutriSoft" as keyword. You can also specify a particular filename if 
the search fails to list all of our software products.

After you complete the CompuServe registration process, we will be notified and the upgraded registered 
software diskette(s) will be sent to you by airmail (international addresses) or first-class mail (U.S. 
addresses).

See also Registration by Credit Card



Registration by credit card

[This page can be printed by selecting 'Print topic' from the File pull-down menu.]

Credit card users can register for any NutriSoft products through the PsL (Public software Library) 
Registration Service. There is a PsL $2 handling fee for each item ordered: a product priced at $39 will 
cost you $41, for example; however, you save time and postage by taking advantage of this service. If 
you don't mind the few days delay for the regular postal mail to reach us, it is cheapest to order directly 
from NutriSoft using check or money order (no credit card). In addition, if you wish to receive the 20% 
discount when ordering 3 or more items, you will need to register directly with NutriSoft. Neither PsL nor 
CompuServe can process this discount. The $1 airmail surcharge (for international order only) applies 
whether you register through PsL, CompuServe, or directly with NutriSoft.

Please call 1 - 800 - 2424 - PsL ( 1-800-242-4775 ) or 713-524-6394 

PsL Registration Service can also be reached
by FAX (713) 524-6398
by CIS Email 71355,470
by Internet Email 71355.470@compuserve.com
by mail P.O.Box 35705, Houston, TX 77235-5705.

Please note the above phone numbers and addresses are for registration by credit card only. Any 
questions about the status of the shipment of the order, product details, technical support, volume 
discounts, dealer pricing, site licenses, etc., must be directed to NutriSoft. You get quickest answers by 
sending email directly to NutriSoft.

To insure that you get the latest version, PsL will notify NutriSoft the day of your order and NutriSoft will 
ship the product directly to you.

List of NutriSoft products that can be registered through the PsL Registration Service:
(please mention the number preceding the program name: its PsL registration ID)

1)    11551 Fat and Cholesterol Counter for Windows v. 1.1 ($21)

2)    11553 NutriSoft Weight Perfect for Windows v. 3.0 ($37)

3)    11554 NutriSoft Pregnancy Nutrition for Windows v. 2.1 ($41)

4)    11690 NutriSoft Healthy Heart Nutrition for Windows v. 3.5 ($37)

5)    11557 NutriSoft Reduce Cancer Risk for Windows v. 3.0 ($41)

6)    11558 NutriSoft Lower Your Cholesterol for Windows v. 3.2 ($41)

7)    11582 NutriSoft High Blood Pressure Nutrition for Windows v. 3.2 ($41)

8)    11583 NutriSoft Diabetic Nutrition for Windows v. 3.3 ($41)

9)    11689 NutriSoft Pyramid Weight Loss Diet for Windows v. 3.4 ($31)

10)    11755 NutriSoft Nutrition for Women for Windows v. 3.5 ($41)

11)    11883 NutriSoft Eat Well, Weigh Less for Windows v. 3.5 ($39)

12)    11884 NutriSoft Omega-3 Counter for Windows v. 3.4 ($21)



See also 
German edition registration
Registration via CompuServe



Registration form - German products
[This page can be printed by selecting 'Print topic' from the File pull-down menu.]

The following NutriSoft products are available in the German edition which uses a German food database.
[ This database has approximately 1.000 food items, however, we regularly update and enlarge our food 
databases and will send you the latest available data. ] Currently these items can be registered only 
directly with NutriSoft or through the CompuServe Shareware Registration service. Please indicate which 
software product(s):

1. NutriSoft Ernährung für Frauen for Windows v. 3.5 $39
2. NutriSoft Ernährung bei Diabetes for Windows v. 3.5 $39
3. NutriSoft Das optimale Gewicht for Windows v. 3.5 $35
4. NutriSoft Ernährung bei Bluthochdruck for Windows v. 3.5 $39
5. NutriSoft Diät bei Herz-Kreislauf-Erkrankungen for Windows v. 3.5 $39
6. NutriSoft Cholesterinsenkende Kost for Windows v. 3.5 $39

Name:

Address:

City: State: Postal Code:

How did you obtain this NutriSoft shareware? _______________________________

Your email address, if available: _______________________________

Please remit in U.S. currency and send check or money order to

NutriSoft
P.O. Box 8226

Stanford, CA 94309
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Program's Icons and Buttons
This is a comprehensive list of shortcuts via icons and buttons to all NutriSoft utilities, some icons may not
be accessible in this program because their utilities are not available. If an icon is not described in this list,
you can obtain its description via the context-sensitive help button (the last button) on the application 
toolbar.

Pyramid analysis:

brings up a dialog box which uses the USDA Food Guide Pyramid to analyze your diet.

Fat content:

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.

Click on either of these icons to specify the fat percentage where you want to be warned when exceeded.

Caloric analysis:

clicks this icon to see graphic analysis of calories from fat, protein and carbohydrate for selected food 
item.

Sorting:
Nutrients are sorted based on values in 100g of food.

clicks this icon to sort the items in the listbox in ascending order.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the 
nutrient's value.

indicates the food items are sorted in descending order.

Food groups viewing:
Since there can be more than 50 food groups in our database and an average screen can display only 
about 30 food groups at a time, these buttons make it more convenient to view the food groups (when you
hold down the mouse on the drop down listbox) by displaying them in normal order (first group first) or 
reverse order (last group first). You can select a food group by the mouse or by typing in the first letter of 



the food group's name.

displays food groups in normal order in drop down list box. Instead of clicking on this icon, you can use 
alt-n (Normal).

displays food groups in reverse order in drop down list box. Instead of clicking on this icon, you can use 
alt-r (Reverse).

indicates food groups are displayed in normal order.

indicates food groups are displayed in reverse order.

Searching:
Since there can be up to approximately 10,000 food items in our food database in addition to other items 
in user's database, this search facility makes it easy for you to locate any particular food by name. [Some 
of our programs come with a standard database of about 1,000 food items. Please see the readme.txt file 
for the database size of a particular program.] You can do a global or a local search. You can specify that 
the result include or exclude certain food items. 
Example: to find all foods containing 'yogurt', you type this string (without the quotes) into the edit control 
and click the global search icon. [If you don't see the search icons, you need to select Options then 
Search mode from the main menu first.] The result is displayed in the listbox below when the search is 
completed. To exclude all vanilla yogurt, you type the string '!vanilla' (without the quotes) into the edit 
control and click the local search icon. [Don't leave a space before your search text or after the 
exclamation point because blank space is significant in the search.] To narrow the result further, you can 
do another local search on the non-vanilla yogurt items; or you can proceed to another global search.

Enter search mode

Global search: searches both the NutriSoft and user databases for a food item containing or not 
containing a text string. You can use alt-g (Global) instead of clicking on this icon.

Local search: searches only the listbox's content for food items containing or not containing a text string. 
This is convenient for pruning down a previous search result which might contains hundreds of food 
items. You can use alt-l (Local) instead of clicking on this icon.

Quick Find:
If your current day's diet is too high in fat, for example, you can use this feature to quickly locate the item 
most contribute to this problem and adjust your consumption accordingly.

locates the food item in the current day's consumption that has the highest content of a particular nutrient.



locates the food item in the current day's consumption that has the lowest content of a particular nutrient.



View menu commands

The View menu offers the following commands:

Caloric Analysis Shows graphic analysis of percentage of calories from protein, 
carbohydrate and fat.

Nutrient Analysis Shows graphic analysis of the individual nutrient contents from your
daily food consumption.

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Cholesterol Profile Analyze your blood cholesterol levels and your heart disease risk
Weight Control Plan Use this dialog box to set short and long-term plan for weight 

control.
Desirable Weight Determine your ideal weight based on your sex, height and body 

frame.
Body Mass Index Compare your body mass index with the general population's
Caloric Need Find out your daily caloric need.
Caloric Expenditure Find out how much energy is used in common activities



Options menu commands

The Options menu offers the following commands:

Search Mode Allow you to search for any specific food from the 
standard and personal food databases.

Food Groups Mode Display food items according to food groups.
Personal Food Database Display food items from your personal food 

database.
Show CSI Toggle the display of Cholesterol Saturated Fat 

Index
Reverse Food Groups Reverse the display order of food group names
Choose Printer Font Select your favorite printer font for your nutritional 

and weight planning report.
Choose Screen    Color Select your favorite color for your screen 

background.
Set Nutrient Intake Preference Set your preferred ranges of nutrient intakes. The 

color of the RDA analysis bars will reflect your 
preference.

Set Fat Warning Level Set threshold beyond which you are alerted when 
a food item has more than certain percentage of 
calories from fat.

Left Mouse Button Quick Input Toggle the use of left mouse button for quick 
serving input

Right Button: Gram Quick Input 
Mode

Hold down the right mouse button on the window 
background will display serving amount in grams 
for quick selection.

Right Button: Ounce Quick Input 
Mode

Hold down the right mouse button on the window 
background will display serving amount in ounces
for quick selection.

Right Button: Serving Quick 
Input Mode

Hold down the right mouse button on the window 
background will display common serving sizes for 
quick selection.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Setup Selects a printer and printer connection.
Exit Exits program.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document (file) in "Reduce Cancer Risk". A document (file) contains all
the information regarding the foods you consume during a day. You can open an existing document with 
the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which "Reduce Cancer Risk" stores the file that you want to open. 

Directories
Select the directory in which "Reduce Cancer Risk" stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    "Reduce Cancer Risk" suggests
that you save changes to your document before you close it.    If you close a document without saving, 
you lose all changes made since the last time you saved it.    Before closing an untitled document, 
"Reduce Cancer Risk" displays the Save As dialog box and suggests that you name and save the 
document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, "Reduce Cancer Risk" displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    "Reduce Cancer Risk" displays the Save As 
dialog box so you can name your document.    

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    "Reduce Cancer Risk" adds the extension 
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control 
planner will look for them in this directory.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your "Reduce Cancer Risk" session.    You can also use the Close command on
the application Control menu.    "Reduce Cancer Risk" prompts you to save documents with unsaved 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in "Reduce Cancer Risk", such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in "Reduce Cancer Risk",

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    "Reduce Cancer Risk" displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, "Reduce Cancer Risk" displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the "Reduce Cancer Risk" window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

"Reduce Cancer Risk" displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose a document 
from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using "Reduce Cancer Risk" and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



Context Help command 

Use the Context Help command to obtain help on some portion of "Reduce Cancer Risk".    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the "Reduce Cancer Risk" window, such as another Toolbar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button

Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the "Reduce Cancer Risk" window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    "Reduce Cancer Risk" determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    "Reduce Cancer Risk" determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




